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About the Quadrus MINI Velocity
About the Quadrus MINI Velocity

The key features of the Quadrus MINI Velocity are:

* Q-Mode ultra-high-speed image processing

* WVGA optics

* Global shutter image sensor

+ 256 Mbit SDRAM capacity

+ Ultra-High Density and Standard Density resolution options

+ Software-adjustable focus

+ USB, RS-232, and RS-422/485 connectivity

» Support for both linear and 2D symbologies

* High-output LED illumination

« A multi-function EZ Button for location, calibration, and symbol reading
» A blue target pattern that identifies the center point of the field of view
» A green flash (visible from all angles) to signal a successful read

» Easy customization for a variety of specific applications

About This Manual

This manual provides complete information on setting up, installing, and configuring the
imager. The chapters are presented in the order in which an imager might be set up and
made ready for operation.

Highlighting

Serial commands, highlighted command fields, and default command settings are highlighted
in rust bold. Cross-references and web links are highlighted in blue bold. References to
ESP, its toolbar headings (Communications, Read Cycle, Symbologies, etc.), menu
topics, and other points of emphasis, are highlighted in Bold Initial Caps.

Host Communications

There are three ways to configure and test the Quadrus MINI Velocity:

» Microscan’s Windows-based ESP (Easy Setup Program), which offers point-and-click ease
of use and visual responses to user adjustments.

» Serial commands, such as <K100,1>, that can be sent from ESP’s Terminal window or
another terminal program.

« EZ Button.
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Warning and Caution Summary

/ I

WARNING

LED LIGHT
DO NOT VIEW DIRECTLY WITH OPTICAL INSTRUMENTS
CLASS 1 LED PRODUCT

LED Output: .564 mW. Wavelength: 470 nm; 525 nm; 617 nm.
IEC 60825-1:1993+A1:1997+A2:2001

- /

+ Viewing the Quadrus MINI Velocity’s LED output with optical instruments such as magnifiers,
eye loupes, or microscopes within a distance of 100 mm could cause serious eye injury.

* Maximum LED output: .564 mW.
» Wavelength: 470 nm; 525 nm; 617 nm.
* Location of the Quadrus MINI Velocity’s LED aperture window:

LED Aperture Window

CAUTION: Use of controls or adjustments or performance of procedures other than those
specified herein may result in hazardous radiation exposure.

IMPORTANT: The Quadrus MINI Velocity is intended for connection to a UL-listed direct
plug-in power unit marked Class Il and rated 5 VDC at 3.5 Watts, or greater if using electrical
accessories.

European models must use a similarly rated Class | or Class Il power supply that is certified
to comply with safety standard EN 60950.
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Statement of Agency Compliance

Statement of Agency Compliance

S

The Quadrus MINI Velocity has been tested for compliance with FCC (Federal Communications
Commission) regulations and has been found to conform to all applicable FCC Rules
and Regulations.

To comply with FCC RF exposure compliance requirements, this device must not be co-located
or operate in conjunction with any other antenna or transmitter.

Changes or modifications not expressly approved by the party responsible for compliance
could void the user’s authority to operate the equipment.

C€

The Quadrus MINI Velocity has been tested for compliance with CE (Conformité Européenne)
standards and guidelines, and has been found to conform to applicable CE standards,
specifically the EMC requirements EN 55024:1998+A1:2001+A2:2003, ESD EN 61000-4-2,
Radiated RF Immunity EN 61000-4-3, ENV 50204, EFT EN 61000-4-4, Conducted RF
Immunity EN 61000-4-6, EN 55022:1998+A1:2000+A2:2003 for Class A products, Class B
Radiated Emissions, and Class B Conducted Emissions.

The Quadrus MINI Velocity has been tested by an independent electromagnetic compatibility
laboratory in accordance with the applicable specifications and instructions.
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Statement of RoHS Compliance

All Microscan readers with a ‘G’ suffix in the FIS number are RoHS-Compliant. All compliant
readers were converted prior to March 1, 2007. All standard accessories in the Microscan
Product Pricing Catalog are RoHS-Compliant except 20-500013-01 and 98-000039-02.
These products meet all the requirements of “Directive 2002/95/EC” European Parliament
and the Council of the European Union for RoHS compliance. In accordance with the latest
requirements, our RoHS-Compliant products and packaging do not contain intentionally
added Deca-BDE, Perfluorooctanes (PFOS), or Perfluorooctanic Acid (PFOA) compounds
above the maximum trace levels. To view the document stating these requirements,
please visit:

http://eur-lex.europa.eu/LexUriServ/LexUriServ.do?uri=CELEX:32002L0095:EN:HTML

and
http://eur-lex.europa.eu/LexUriServ/LexUriServ.do?uri=0J:L:2006:372:0032:0034:EN:PDF
Please contact your sales manager for a complete list of Microscan’s RoHS-Compliant products.

This declaration is based upon information obtained from sources which Microscan believes to be reliable, and
from random sample testing; however, the information is provided without any representation of warranty,
expressed or implied, regarding accuracy or correctness. Microscan does not specifically run any analysis on our
raw materials or end product to measure for these substances.

The information provided in this certification notice is correct to the best of Microscan’s knowledge at the date of
publication. This notice is not to be considered a warranty or quality specification. Users are responsible for
determining the applicability of any RoHS legislation or regulations based on their individual use of the product.

Regarding “RoHS Directive 2011_65_EU” Microscan produces Monitoring and Control Instruments as well as
Industrial Monitoring and Control Instruments as defined within the directive. Microscan has developed and is
implementing a RoHS2 compliance plan with the intention of bringing all active products listed in our current
marketing literature within full compliance as per the directive deadlines.

Key milestones for the transition plan are as follows:

« Complete internal product audit and supplier transition by July 2013.

+ Initial “Monitoring and Control Instruments” RoHS2-compliant products available by July 2014.

+ Initial “Industrial Monitoring and Control Instruments” RoHS2-compliant products available by July 2015.
» All new products introduced in 2014 are expected to be WEEE and RoHS2 compliant.

Microscan will mark the products with the ‘CE’ marking that complies with the RoHS2 process to acquire ‘CE’ certification
per the example given: Example 1 >> Machinery directive + EMC directive + RoHS2 = Declaration of Conformity.
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I | Quick Start

Contents
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Step 11 Save Configuration iN ESP .........cciiiiiiiice e 1-14

This chapter is designed to get your Quadrus MINI Velocity up and running quickly, using
the EZ Button or ESP (Easy Setup Program). Following these steps will allow you to get a
sense of the imager’s capabilities and to test symbol decode performance.

Detailed setup information for installing the imager into your actual application can be
found in the subsequent chapters.
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Check Required Hardware

Step 1 — Check Required Hardware

Item Description Part Number
1 |Quadrus MINI Velocity FIS-6300-300XG
2 |IC-332 Adapter FIS-0001-0035G
3 IB-131 Interface Box 99-000018-01
4  |Power Supply (90-264 VAC, 24VDC, USA/Euro plug) 97-100004-15
5 |Object Detector 99-000017-01
6 |Communication Cable 61-300026-03

Network

Hardware Required

Caution: Be sure that all cables are connected BEFORE applying power to the
system. Always power down BEFORE disconnecting any cables.
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Quick Start
Step 2 — Connect the System

Connecting by RS-232/RS-422/RS-485

« Connect the imager (1) to the IB-131/IC-332 interface (2) and (3).

< Connect the host cable (6) to the host and to the host port on the IB-131 (3).
« Connect the object detector (5) to the IB-131 (3).

» Connect the power supply (4) to the I1B-131 (3).

* Apply power to the imager.

Important: If you are using a USB model, you must connect the device to the host computer
before powering-on. Otherwise the unit will not be recognized as a USB device.

Network

Hardware Configuration

Caution: Be sure that all cables are connected BEFORE applying power
to the system. Always power down BEFORE disconnecting any cables.

Quadrus MINI Velocity User’s Manual 1-3



Position Imager and Symbol

Step 3 — Position Imager and Symbol

 Position the imager at a focal distance between 2 and 6 inches from the symbol.

 Tip the imager relative to the symbol to avoid the glare of direct (specular) reflection. The
case parting line should be perpendicular to the plane of the symbol by either pitching the
symbol or the imager as shown.

 Position the imager in a place with as little ambient light as possible.

» Symbols can be rotated (tilted) at any angle; however, for best results symbols should
be aligned with the FOV (field of view).

Parting Line__ :.

Stand ——~

Focal distance

Imager and Symbol Orientation

* In the case of linear symbols, aligning the bars in the direction of their movement (“ladder”
orientation) will minimize the chances of blurring, and will produce better reads.

Important: Avoid excessive skew or pitch. Maximum skew is +30°; maximum pitch is
+30°. The illustration below shows skew axis, pitch axis, and tilt axis.

Skew
<:'>
<
Py
Tilt
Symbol ' !

< 7(\
A} Pitch

Reader

Note: For accuracy of testing and performance, Microscan recommends using a mounting
arm adapter kit. Contact your Microscan sales manager for details about mounting arm
adapter kits and other accessories.
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Quick Start

Step 4 — Install ESP

Easy Setup Program (ESP) is Microscan’s proprietary setup and testing application. The
purpose of ESP is to provide a quick and easy way to set up and configure Microscan readers.

When the Quadrus MINI Velocity is connected to a host computer (Windows Vista, XP, or
2000), ESP can be used to configure reader settings and to set up communications
between the reader and host.

If installing from the Microscan Tools CD:

A WN P

. Insert the Microscan Tools CD in your computer’s CD drive.

. Select ESP Software from the navigation bar at the left of the screen.

. Click on ESP Software under the Current Version heading.

. Click the Run button and follow the prompts in the ESP Setup Wizard.

Note: During installation, you may see an Internet Explorer Security Warning that
states: “The publisher could not be verified.” If you see this warning, click Run to
continue installation.

If downloading from the web:

1.
2.

3.

6.

Go to the Download Center at www.microscan.com.

Create a new member account or, if you are already a member, enter your user name
and password.

Navigate to the “Microscan Software” section of the Download Center (near the top of
the page).

. Click on the link showing the latest version of ESP. Extract the ESP installation files to

a location of your choice on the host computer. Note where your ESP.exe file is stored
on your hard drive.

. At the end of the installation process, the following icon will appear on your desktop:

Click the ESP icon to start the program.

System Requirements for ESP

* 166 MHz Pentium processor (recommended)
Windows Vista, XP, or 2000 operating system
Internet Explorer 5.0 or higher

64 MB minimum RAM

40 MB minimum disk space

800 x 600 pixel minimum 256 color display
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Select Model

Step 5 — Select Model

When you start ESP, the following menu will appear:

Curent l Legacy ]

Select a Model:

Quadmus EZ Quadms Quadrus MINI - Quadruz MINI
MIMI 3 Welacity

L4
¢

®
0
¢
.

M5-4 MS-3 Lazer MS-2 M5-1

M5-830 MS-8E0 MS-820 M5-9

oy
i
v
~

M5-Connect  MS5-Connect  Quadius Verfier  MS-0
5100 210

Description;  |Huadus MINI Velocity-1

¥ Show thiz dialog at startup

™ Skip EZ Mode oK | Cancel |

1. Click the button showing the Quadrus MINI Velocity.
2. Click OK.

Note: You can also double-click the Quadrus MINI Velocity button to make your selection.
3. Click Yes when this dialog appears:

ESP X

\:.f/ wi'ould wiaou like to connect o the Quadrus MINI Yelocity?

Yes Mo | Iﬁ '

Switch Model

Note: If you need to select another model later, click the Switch Model button near
the top of the screen or use Model > New Model in the menu toolbar.
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Quick Start
Step 6 — Select Protocol and Connect

« Choose the connection protocol you are using and click Next when the Select Protocol
dialog appears.

Select Protocol §|

Pleaze zelect the protocal to use:

—P{* R5-232
" USB

< Back Mewt » Cancel

« Once you select your communications mode, follow the prompts to establish your
connection.

Select Protocol X

Please select the protocal to use:
RS-232 X)
* R5-232
© use
Select the com port to use and press Firish to autoconnect to the

reader, Othenwise select the “Foree Connect’ checkbox to
cornect at the specified settings:

If you choose RS-232 protocol: B o fon -
™ Foroe Comnec Click Connect.

<Back Cancel

Select Protocol 5]
Select the
Please sslect the protocal to use: Quadrus MINI
# ez Velocity from
& UsE One reader was found. the Select
Device menu
If you choose USB protocol: ————— B sce and click
Finish.
Bl

<Back Cancel
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Select Protocol and Connect (cont.)

Step 6 — Select Protocol and Connect (cont.)

When you are connected, you will see the green connection indicator in the status bar at
the bottom right of your screen.

RS-232: EORRESTEENNN Foint-to-Poink (COM1 (115.2K:MN:G:1
UsB: [EONNECTEENNN sk HID

« If your RS-232 connection attempt fails, click the Autoconnect button, select a different
communications port, and try again.

Note: If your RS-232 host settings cannot
be changed to match the imager’s settings:

e Click Connect on ESP’s menu toolbar, s, B
and then select Connection Wizard.
* When the Select Protocol dialog Please seect the protosel s
appears, select RS-232 and click Next. —— P sz
 UsE

<Back Nest » Corcel |

* When the RS-232 dialog appears, RS 232 ®
check the Force Connect box and _
click the Connect button. = ‘EEZE&ESSJ:‘;{;Z“‘é&f&i‘:‘ﬁ?&ﬁ e
connect at the specified settings.
Com Part:  |COMT

f Force Connect Settings..

< Back Connect Cancel
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Quick Start
Step 7 — Locate the Symbol in the Field of View
Locate by ESP
« In ESP’s EZ Mode, click the Locate button to enable the blue target pattern.

| Locate | Calibrate | I~ Fast

Test Stop | FAS

[~ Decodes perSecond [ AEC ,ﬁ;l 4,00 inches

The symbol in the field of view will appear in the video view beneath the Locate and

Calibrate buttons, and you will see the blue target pattern projected from the front of the
imager.

« Center the target pattern on the symbol.
At 2 to 3 inches, the pattern resembles an X. At 3 to 6 inches, the pattern resembles a V.

Center on object
in field of view.

:

<

Target pattern shown as it would appear between 3 and 6 inches.

Important: The entire symbol should fall within the field of view (FOV) of the imager. The
field of view is what appears in ESP’s Locate/Calibrate window in EZ Mode.

« Click the Stop button to end the Locate function.
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Locate the Symbol in the Field of View

Locate by EZ Button

If you are not connected to a host computer, the EZ Button allows you to locate a symbol
in the imager’s field of view.

EZ Button

» Hold down the EZ Button for about one second and release when you hear one short
beep. The amber 20% LED will illuminate, and you will see the blue target pattern projected
from the front of the imager.

» Center the target pattern on the symbol.

Note: To end all EZ Button functions, press the EZ Button once and quickly release.
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Quick Start

Step 8 — Calibrate

Quadrus MINI Velocity settings can be adjusted automatically for optimum symbol
decoding performance by either the EZ Button or by ESP.

During the calibration routine, the reader will flash its amber Read Rate percent LEDs and
red illumination LEDs while searching camera settings and determining the best configuration
for decoding symbol data. Upon successful completion of this routine, a green LED pattern
will flash brightly and illuminate the symbol. If unsuccessful, the imager will emit 5 short beeps
and stop searching.

Calibrate by EZ Button

1. Hold down the EZ Button for about two seconds and release when you hear two
short beeps. The 20% and 40% LEDs will illuminate.

2. The imager will search camera settings to determine the best configuration for decoding
symbol data.

Note: To end all EZ Button functions, press the EZ Button once and quickly release.

Calibrate by ESP
1. Click the Calibrate button.

Calibrate

2. The imager will search camera settings to determine the best configuration for decoding
symbol data.

A successful calibration will display a green frame around the symbol, and the following
message will appear: “Uploading all reader parameters.” After a moment the symbol
data will be presented in the field below the image display window.

Calibrate by Serial Command
Send <@CAL> from a terminal program to begin calibration.
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Test Read Rate
Step 9 — Test Read Rate

Read Rate indicates the number of successful decodes per second achieved by the

imager.

Test Read Rate by EZ Button

1. To start the Read Rate test, hold
down the EZ Button about three
seconds until you hear three
short beeps. The 20%, 40%, and
60% LEDs will illuminate.

While the symbol is being
inspected, the Read Rate LEDs
will indicate the corresponding
read rate percentage on the back
of the unit.

20%, 40%, 60%, 80%, 100%.
These LEDs represent the
percentage of Good Reads
per images captured.

2. To end the Read Rate test, press the EZ Button and quickly release.

Test Read Rate by ESP

1. Click the Test button to start the Read Rate test and Stop to end it.

Test Stop

[v Decodes per Second

If a symbol has been successfully decoded, the symbol’'s data and related features will
be presented in the field below the image display window. Also, while the symbol is
being inspected, the Read Rate LEDs will indicate the corresponding Read Rate

percentage on the back of the unit.
2. To end the test, click the Stop button.

Note: Read Rate can also be tested using the Read Rate interface in Utilities.

Test Read Rate by Serial Command

You can also start a test with the <C> or <Cp> command and end it with the <J> command.

1-12
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Quick Start

Step 10 — Configure the Imager in ESP

To make setup changes to Quadrus MINI Velocity, click the App Mode button.

&b

App Mode

The following modes are accessible by clicking the buttons in the first row of App Mode icons:

@ = Ci? @_ X:x (3] g:l E DATA

-

EZMode  Autoconnect Send/Recy  Switch Madel Configuration Camera Terminal LIiIitis Cukput Faorrmak

 Click the Autoconnect button to establish communications between ESP and the imager.

 Click the Send/Recv button to send or receive commands.

 Click the Camera button to access a live Video view, Evaluate image captures, Calibrate
the imager, set the Window of Interest, fine-tune capture settings and processing settings
in the Configuration Database, and control multiple read cycle functions in Dynamic Setup.

 Click the Terminal button to display decoded symbol data, and to send serial commands
to the imager using text or macros.

« Click the Utilities button to test Read Rate, request or clear Counters, enable or disable
the imager or send output pulses in Device Control, determine the Differences from
Default in the current settings, add or remove master symbol data in Master Database,
and verify or update the imager’s Firmware.

* Click the Output Format button to determine the order and content of data output.

Click the Configuration button to display the second row of ESP icons.

=
e
Configuration

From here you can make changes in the tree controls that can be accessed by clicking the
buttons on the second row of icons in the ESP window.

f %5' T._.: ﬁ ’\1‘-:‘.

Communication  Read Cycle Symbologies I Syrbol Quality  Matchcode Diagnostics

For further details, see Microscan ESP Help in the dropdown Help menu.

CQuick Skart Help %

About ESP...
Contacting Microscan...
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Save Configuration in ESP

Step 11 — Save Configuration in ESP

To make changes to a configuration setting:

FParameters
—|- Cammunications
- RS232[422 Hosk Park

+- Host Prokocol
Hosk 422 Stakus
+-RS232 Auxiliary Paork
+- USE HID Report Status

L. Left-click on the + v/ [0 1| AN | isablec =

to expand the
desired tree. +- Postamble _

2. Double-click on the Response Timeout
desired parameter LR Status

and click once in the

selection box to view Az Port System Data Skatus

ESP %alues

+|- Hosk Port Connections

3. Place your cursor in the
selection box, scroll down to
the setting you want to
change, and click once on

the setting.

E nabled

options. #

4. Left-click again on the open
screen to complete your
selection.

Saving Options

Disabled

Disabled
5. Right-click on the open
screen and select Save to
Reader to implement the
command in the imager.

» Send, No Save. Changes will be lost when power is re-applied to the imager.
* Send and Save. This activates all changes in current memory and saves to the imager

for power-on.
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I ” Using ESP
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This section is designed to help you understand the basic structure and elements of ESP
(Easy Setup Program).

When you open ESP, unless otherwise specified in the ESP Preferences dialog accessible
from the Options heading on the menu toolbar, you will enter EZ Mode for initial setup.
From there, you can enter Application Mode (App Mode) and access several configuration
menus (Communications, Read Cycle, Symbologies, I/O Parameters, Symbol Quality,
Matchcode, and Diagnostics), a Camera setup interface, a Terminal interface, a Utilities
interface, and an Output Format interface.

ESP can be used to configure the Quadrus MINI Velocity in three different ways:

» Tree Controls: Each configuration menu contains a list of all option settings that pertain to that
specific element of imager operation. For example, the Communications menu shows a
Host Port Connections option, and then a list of the sub-options Baud Rate, Parity, Stop
Bits, and Data Bits. Each of these sub-options is configurable by using dropdown menus.

« Graphic User Interfaces: Imager settings can be configured using such point-and-click
tools as radio buttons, zoom in/zoom out sliders, spin boxes, check boxes, and drag-and-drop
functions.

« Terminal: ESP’s Terminal allows you to send serial configuration and utility commands
directly to the imager by typing them in the provided text field.

Information about using ESP in specific applications is provided in subsequent sections.

For ESP system requirements, see ESP System Requirements in Chapter 1, Quick Start.
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EZ Mode

EZ Mode

In EZ Mode you are presented with the Locate, Calibrate, and Test options. After connecting
to your imager, EZ Mode is the screen you will see. You will be provided with on-screen
instructions that will help you with positioning, testing, and calibration.

Test

Click the Test button to start the Read Rate test for a quick indication of the imager’s read
capabilities and the limits of your application. When Decodes per Second is unchecked,
the test will count the percentage of decodes relative to the number of actual scans. Click
Stop to end the test.

Calibrate

The calibration routine that will optimize the imager by comparing Read Rates at various
camera and image processing settings.

Enter App Mode to
access configuration
trees and other setup
features.

Click Calibrate to begin the initial
E5E ESP - Untitled calibration routine. Calbration is
explained at the left of the EZ Mode
screen, and also in Quick Start.

File Model Options Connect Help

«°o = B

App Mode  Autoconnect Switch Model

| >

’7; Locate | Calibrate | [~ Fast

| .

Welcome to Easy Setup Program

Click Locate to activate the Quadrus MINI Velocity's blue
target pattern LEDs. Center the target pattern on the symbol.
The display shows you where the symbol is located in the
imager’s field of view.

Starts Read Rate test.

Test

' &
[ Decodes per Second® [~ AEC 'fg 0.00 inches

For Help, press F1, COMMECTED

Ends Read Rate test.
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Application Mode

From EZ Mode, you can click on the App Mode button to access specific configuration

Using ESP

menus, Utilities tools, Camera setup, Output Format options, and a Terminal window

where serial commands can be entered.

&b

App Mode

Note: The App Mode and EZ Mode buttons appear in the same position to allow easy

switching between these primary modes.

Database.

Click here for Camera Setup, advanced Calibration, Configuration

Click this icon to

return to EZ Mode.

Menu toolbar.

ESE ESP - Untitled
File Maodel Options Conne:

2 =

EZ Mode

a %

Communication  Read Cydle

ct View Help

=} ? E-%
e

= W | =

Autoconnect  SendfRecy  Switch Model Cxﬁguratinn

O /- a—

Symbal Quality

By ~

Symbologies It

Matcheode

Click here to open
the Terminal view.

Terminal Ltilities

Click here for
Ordered Output
and Output Format
features.

DATA 4—‘

Qubput Format

Diagniostics

Parameters

R5232/422 Host Port

Eaud Rate
Parity
Stop Bits
Data Bits
=] Host Protocol
Address
- ACK | MAK Op

Hosk 422 Status
R5232 Auxiliary Port
+|- Au Port Connect
+- A Port Settings
Craka Cutput
Preamble
Postamble
Response Timeouk
LR Status

¥

¥

¥

Far Help, press F1.

=I-Host Park Connections

+|- Polling Mode Options

Click the Configuration icon to return to full
App Mode view from Camera, Terminal,
Utilities, or Output Format.

Click on icons in this row to

access configuration trees
like the one shown here.

Cne

Eight -

Point-to-Paink

1

tions Click Capture and Decode to

Disabled

jons

Disabled
Enabled
12

Disabled

read the symbol in the field of
view, and to see a high resolution
image capture of the symbol.

apture and Decode

Decoded symbol data
is shown in this table.

Atribute

Walug

|
|
CONNECTED |

Note: For specific information on any of the icons shown above in the operations bar or
configuration bar, see the corresponding chapters in this manual.
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Menu Toolbar

Menu Toolbar

File > New
Whenever New is selected, the default configuration of ESP is
loaded. .

e Chrl4+-M
Open/Save Open...  Chr+0
When Save or Save As is selected, the ESP configuration is Jave Ctri+5

saved to the host computer’s hard drive and available whenever Save As...
the same file is selected under Open.

Important: When you save menu changes to your hard drive,
these changes are not saved to your imager. The illustration Impart. .
below shows how settings can be saved and received between
ESP and the imager, and ESP and the host hard drive.

Prink. .. Chrl+FP

Export. ..

Recent File

Exxit

(Save to Imager)

(Receive Imager
Settings)

Import/Export
Import converts the ASCII settings from a text file to ESP configuration settings.
Export converts the active ESP configuration settings to an ASCII text file.
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Using ESP
Model

In the Model menu you can select any of the models supported by ESP. When you choose
a different model, the connection to your present model will be terminated.

Quadrus MINI Yelocity  #

* Quuadrus MINI Velaciky-1
Mew Model, ..
Remove Model,,.

To connect to another model, select New Model, choose a new model from the pop-up
menu that appears, and click OK.

Note: When you save an ESP file, you are saving the settings of all the models defined in
that file.
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Menu Toolbar

Options

The Options menu allows you to save memos and set up ESP

Cptions
Preferences.
Note: Preferences will be saved and loaded into ESP whenever ESP Preferences
is opened next, whether or not you save the ESP file. Diacument Merno
Model Memo

Preferences > General Tab

Preferences g|

General ] Terminal] Bar Code Dptionsl .&dvanced]

The Toolbar Style
options allow you to

[~ Reload Last File {* Shaw Bath lcon and Text determine how ESP
will display the mode
options in the two rows
[¥ Shaw Connect Prompt " Only Show Test at the top of the screen.

On Startup Toolbar Style

v Show Model Prampt " Only Shaw |con

™ Receive After Connect

™ Skip EZ Mode

| Enable 'Send and S ave as Customer Defaults'

Drefault Settingz
ak. | Cancel |

Reload Last File
At startup, reloads the last file saved to the host computer’s hard drive.

Show Model Prompt
At startup, shows the model menu displaying all supported readers.

Show Connect Prompt
At startup, displays the Would you like to connect to the Quadrus MINI Velocity? prompt.

Receive After Connect
At startup, loads the imager’s settings into ESP. (This is not recommended if you want to
preserve your ESP settings for future use.)

Skip EZ Mode
At startup, skips EZ Mode and opens directly in App Mode.

Enable ‘Send and Save as Customer Defaults’

At startup, enables the Send and Save as Customer Defaults option in the Send/Recv
command.
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Using ESP
Preferences > Terminal Tab

Preferences E|

General  Terminal ] Bar Code Options 1 Advanced]

¥ Show Mon-Printable Characters
(*
* Default Format (Fast) D B et

" Enhanced Fomat (Slower)
[~ Enable Echo

Change Keyboard Macros... | Bty e e -
ackaround Color:

v Display Incoming Data Even
‘whhen Mot in Focus

Default Settings
oK Cancel

Show Non-Printable Characters

When Show Non-Printable Characters is enabled, characters such as “CRLF” will be
displayed in the Terminal window. When Enhanced Format is checked, the characters
are displayed with more detailed formatting.

Change Keyboard Macros

Clicking the Change Keyboard Macros button brings s &
up the Function Keys dialog. In this dialog you can N e e e e W W G e |
select the desired function key and then enter your

. . Key 2 Clear Key. Clear All Keys
macro keystrokes in the associated key map. For - (=] =

example, to make Ctrl-F2 the keystroke to send a trigger o
character, select F2, then in the Ctrl row, enter <trigger £ |

Ak Shit |

character> and click OK. Then whenever the Ctrl-F2 wo |
keystroke is pressed, the trigger character will start the ] ]
read cycle.

Note: The F1 key is reserved for opening ESP Help and the F3 key is reserved for the
Find Next function.

Change Font

Allows you to modify the font used for decode data received from the imager on the Terminal
screen.

Change Echo Font

Allows you to modify the font used for command characters typed into the Terminal view.
Enable Echo

Allows you to enter command characters in Terminal.

Display Incoming Data Even When Not in Focus

When Display Incoming Data Even When Not in Focus is enabled, data from the
imager will continue to appear in the Terminal even when ESP is not the top window.
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Menu Toolbar

Preferences > Bar Code Options Tab

Preferences

X]

General] Terminal Bar Code Options l.ﬁ.dvanced]

Sizing Infarmation

Bar width 14 [Milz]
ik

Example

| Default Settings |

QK | Cancel |

The Bar Code Options dialog allows you to set the size of user-created symbols.

Sizing Information
Sets the bar width or module width (in mils, or thousandths of an inch) of user-created symbols.

Example: A bar width of 14 is 0.014 inches.
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Using ESP
Preferences > Advanced Tab

Preferences g]
General ] Terminal ] Bar Code Options  Advanced l
Auto Sync
‘when entering a view that supports Auto Sync, do the following:
I Always Ask Before Auto Sync Ocours
+ Receive Settings from the Reader
" Send ESP Seftings to the Reader
" DoMat Send or Receive Settings

I¥ Show Target Pattern During Locate ™ Send#0ON with Autoconnect
™ Show Target Pattern During Calibrate W Ask to 5 ave ESP File when Guitting

I™ Use Higher Quality Images I™ Connect ta readers via TCPAP
¥ Open Image after S ave v Usze Default Storage Location
Default Settings
(] 8 | Cancel |

The Auto Sync options at the top of the Advanced tab allow you to determine whether
Auto Sync will be enabled automatically in sections of ESP where it is used, or if it will ask
you before it enables Auto Sync functions.

Always Ask Before Auto Sync Occurs

If you check this option box, you are then able to determine what specific Auto Sync
functions will be enabled. Receive Settings from the Reader will automatically send the
imager’s settings to ESP when Auto Sync is enabled. Send ESP Settings to the Reader
will automatically send all imager configuration settings chosen in ESP to the imager. Do
Not Send or Receive Settings creates a condition in which Auto Sync will not automatically
send imager settings to ESP, or send ESP settings to the imager.

Show Target Pattern During Locate

Allows you to determine whether the blue LED target pattern will be on or off during the
Locate routine.

Show Target Pattern During Calibrate

Allows you to determine whether the blue LED target pattern will be on or off during the
Calibrate routine.

Use Higher Quality Images

Sets ESP to output images at a higher resolution than standard JPEG format.

Open Image after Save

When Open Image after Save is enabled, ESP automatically opens saved image captures.
Images can be saved from the Evaluation tab in the Camera view, or by right clicking an
image in any other image capture view and then saving.

Send XON with Autoconnect

Sends an XON (Begin Transmission) command to the imager before starting the Autoconnect
routine.
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Menu Toolbar
Preferences > Advanced Tab (cont.)

Ask to Save ESP File when Quitting
When enabled, prompts the user to save a .esp file when ending a session.

ESP X

\__:':j Save changes to session 9,.e5p?

Yes Mo | Cancel |

The .esp file will be saved in the location of your choice.

& My Documents E”‘E|®

:© File Edit Wiew Favorites Tools  Help :,'
: Limks
@ Back - ?) ? ) Search _.;= Folders v

: Address !u,J My Documents v| £ GO
Folders x | Mame - Size  Type
@ Deskkop Al session 9.esp 6 KB ESP Documnent
& |D My Docurments i
= ;é My Computer

[# ﬁ 3 Floppy (A:)

(=) Local Disk {C:) b
< | > £ | b

Connect to Readers via TCP/IP
When enabled, shows a TCP/IP option on the Select Protocol dialog.
Note: This option should only be selected if you intend to connect using an Ethernet adapter.

Select Protocol [zl

Flease select the protocol to use:
* R35-232
C TCPIP <

" Use

< Back | Mext > | Cancel

Use Default Storage Location
When enabled, automatically stores data in ESP’s Application Data folder.
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Using ESP

Document Memo

The information you type in the Document Memo field will appear in a context-sensitive text
box whenever your cursor hovers over the Document Memo item on the Options menu.

Memo r's_<|

Inzert up to 250 characters to dezcribe thiz document.

Type document-specific infarmation here.

Qptions
ak. | Cancel
Preferences

|Ty|:ue document-specific information here, |

Model Memo

Model Memo

Similar to Document Memo, the information you type in the Model Memo field will appear
in a context-sensitive text box whenever your cursor hovers over the Model Memo item on
the Options menu. Memos created in Model Memo are specific to the model enabled
when the message was created.

Memo f'5_<|

Inzert up to 250 characters to dezcribe thiz model,

Type model-specific infarmation here.

Preferences

Docurment Mermo

m |Ty|:|e maodel-specific information here, |

Note: Memos must be saved in a .esp file if you want them to available in your next session.
If you do not save your current session, any memos that you have entered during the session
will be discarded, and will be unavailable in your next session.

Quadrus MINI Velocity User’s Manual 2-11



Autoconnect

Autoconnect

« If your RS-232 connection attempt fails, you can use Autoconnect to establish a connection
between the imager and the host.

% Connecting... fg
g
fAutaconneck Select the COM Port: |COM1 -

Pressz ""Start’ to autoconnect.

Select the COM Part: (COM1 -

Other

« If your communications port is not the default COM1, use the dropdown menu to change

your port.
Connecting... rg|
Select the COM Port: |[COM1 -
« Once you have
chosen the correct JE00:H: 7

port, click Start to

connect. Stop

When you are connected, you will see the green connection indicator in the status bar at
the bottom right of your screen:

CORRESTERNNN Foirt-to-Point (COM1 (152K M :&: 1

Important: If you are using a USB model, you must connect the device to the host
computer before powering-on. Otherwise the unit will not be recognized as a USB
device.

2-12 Quadrus MINI Velocity User’s Manual



Using ESP
Autoconnect (cont.)

If your RS-232 host settings cannot be changed to match the imager’s settings:

¢ Click Connect on ESP’s menu toolbar, ey 5
and then select Connection Wizard. —
. When the SeIECt PrOtOCOI dlalog Pleaze select the protocol to use:
appears, select RS-232 and click Next. —— P R
 USB

<Back Nest > Cancel |

* When the RS-232 dialog appears, #s-232 5]
check the Force Connect box and
click the Connect button. o e e

connect at the specified seltings.

ComPart  [COMT =
4’ ¥ Force Connect Settings.

< Back Connect Cancel
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View

View

The View menu allows you to move quickly between interfaces m
without using the icon buttons on the App Mode toolbar. It also

allows you to access the Bar Code Dialog.

Bar Code Dialog

In the Bar Code Dialog you can create symbols by typing the text you
wish to encode. This is a useful tool for creating configuration symbols, Barcade Dialog
allowing you to configure your reader by reading the symbols you create.

Bar Code Configuration

* Canfiguration
Camera
Terminal
Iitilities
Qutput Farmak

. Drag specific configuration
Print... | Save As.. | values from the control tree
directly into this field to
encode new symbols.
Bar Code Value | < e y

Choose a spatial
orientation for the
new symbol.

aption

2-14

' Same s Bar Code Value

—» Rotation |EI Degrees j I e

Create a caption
for the symbol
that matches the

" Specify

[ Add start configuration code

[ Add end configuration code; Save Settings

| Differences from Default Settings

<4 encoded data, or
write your own
caption.

The symbol you create
will be displayed in the

== field at the bottom of the

Bar Code Dialog.

Quadrus MINI Velocity User’s Manual



Using ESP

Navigating in ESP
To change imager settings, or to access the Utilities, Camera, Terminal, or Output Format
views, click the App Mode button.

&b

App Mode

To return to EZ Mode, click the EZ Mode button.

&

EZ Mode

To make changes to configuration settings in the tree controls:

Parameters ESP % alues ‘
= Camera Setup
—|- Camera Settings The X indicates
1. Left-click on the + to expand Gain & that the setting
) Shutter Speed 1000 is the default.
menu items. Tlumination Brightress High
Faocus Distance 400

2. Double-click the desired
parameter and single-click —
in the selection box to view
options.

3. Place your cursor in the
selection box, scroll down
to the setting you want to
change, and single-click

=I- Camera Features

AECIAGC Mode
AECIAGC Brightness
—|- Window of Interest
Top
Left
Height
“Width
+- Image Processing Settings

Disabled -

the setting.
g 4. Left-click again on the open screen to complete the

selection.

5. Right-click on the open screen and select Save to
Reader to implement the command in the imager.
You can send the command without saving it, or you
can send and save the command simultaneously.

Receive Reader Setkings

Send, No Save
Send and Save
Send and Save as Customer Defaulks

Cefaulk Current Menu Settings
Defaulk all ESP Settings

Advanced Options r
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Send/Receive Options
Send/Receive Options

To access Receive, Save, and Default options, click the Send/Recv button. You can also
access these options by right-clicking in any of the configuration views.

==

-
Send/Recy

Receiving
From the Send/Recv menu, select Receive Reader Settings.

Caution: Do not select this option if you do not want to upload the imager’s settings. For
example, if your ESP file has a number of custom settings that you want to maintain and
download into the imager, these settings would be lost by choosing Yes.

This is useful if you want to receive (upload) the imager’s settings and save them as a file
for future use. For example, if your imager has settings that you do not want to change,
choosing Yes would allow you to load those settings to ESP and save them in an ESP file
for later retrieval.

Receiving the imager’s settings will also assure that you will not be subsequently saving
any unwanted changes that you or someone else has made previously in ESP.

Saving
Send, No Save (<A>)

Saves ESP settings to current
memory.

Receive Reader Settings

Save to Reader Send, Mo Save
) Send and Save
Sen d an d Save (<Z>) Default Current Meruu Settings Send and Save as Customer Defaults
. . Default all ESP Settings
Activates all changes in current
memory and saves to the imager Advanced Options v

for power-on.

Send and Save as Customer Defaults (<Zc>)
Saves your default settings for quick retrieval.

This option will be visible only if you have checked Enable ‘Send and Save as Customer
Defaults’ in ESP Preferences.
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Using ESP
Defaulting

When you select Default Current Menu Settings or Default all ESP Settings, you are
only defaulting the ESP settings.

Advanced Options

Send Current View

This is the same as Save to Reader
> Send No Save except that only the
commands in the current configuration Save bo Reader »
tree are sent.

Receive Reader Settings

Defaulk Current Menu Settings
Defaulk all Settings

Send Current Command

This is the same as Send Current
View, except that it saves only the send Current Command
command that is currently selected. Add Exception

Advanced Options Send Current Wigw

Rernove Exception

Add/Remove Exception

After you perform a Receive Reader Settings command? and you click on the Add Exception
option, you may see a list of serial commands. These are commands that may be in your
imager’s firmware, but not included in, or different from, your current version of ESP.

You can edit these commands by double-clicking on them and changing them as needed.

It is important to note that these commands will be saved to your imager whenever you
send a Save to Reader command, or an <A> or a <Z> command.

Also, if there is a corresponding ESP menu item, the ESP Value column for that item will
be blank following a Receive Reader Settings command.

1. From the Send/Recv button or by right-clicking in any blank section of a tree control view.
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Using EZ Trax

Using EZ Trax

For detailed information about using EZ Trax, refer to the Help menu in EZ Trax software,
or the EZ Trax Quick Start Guide, available on the Microscan Tools CD.

For information about how to configure the Quadrus MINI Velocity for use with EZ Trax,
see Setting Up the Imager for EZ Trax in Chapter 5, Read Cycle.
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This section explains how to set up communications parameters with the host and an
auxiliary terminal.

With Microscan’s ESP (Easy Setup Program), configuration changes can be made in the
ESP menus and then sent and saved to the imager. The user can also send serial commands
to the imager via ESP’s Terminal window.
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Communications by ESP

Communications by ESP

Parameters ESP % alues
ﬁ =~ Communications
App Made R5232/422 Host Port

Click this button R5232 Auxilliary Port
to bring up the I1SE HID Report Status

App Mode view. Preamble Disabled
Poskamble Enabled

.
.
.
.
.
Response Timeouk 12
$ LRC Status Disabled
A Pork System Data Skatus Dizabled® - |
Communication m
Click this button Enabled
to bring up the ‘
Communication To open nested options, To change a setting, double-click the

tree control. single-click the +. setting and use your cursor to scroll
through the options.
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Communications

Communications Serial Commands

Host Port Connections

<K100,baud rate,parity,stop bits,data bits>

Auxiliary Port Connections

<K101,aux port mode,baud rate,parity,stop bits,data
bits,daisy chain ID status,daisy chain ID>

RS-422 Status

<K102,status>

Host Port Protocol

<K140,protocol,address>

Preamble <K141,status,preamble characters>
Postamble <K142,status,postamble characters>
Response Timeout <K143,response timeout>

LRC <K145,status>

Auxiliary Port System Data Status

<K146,aux port system data status>

ACK/NAK Options

<K147,RES,REQ,STX,ETX,ACK,NAK>

Polling Mode Options

<K148,RES,REQ,STX,ETX,ACK,NAK>

Autoconfiguration Daisy Chain
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Host Port Connections

Host Port Connections

The host port can be configured with RS-232, RS-422, and RS-485 connections.

The following settings define the basic transmission speeds and digital standards that
ensure common formatting.

Baud Rate, Host Port

Usage: Can be used to transfer data faster or to match host port settings.
Definition: The rate at which the reader and host transfer data back and forth.
Serial Cmd: <K100,baud rate,parity,stop bits,data bits>
Default: 115.2K
Options: 0 =600 1=1200 2 =2400
3 =4800 4 =9600 5=19.2K
6 = 38.4K 7 =57.6K 8 = 115.2K
9=230K
Parity, Host Port
Usage: Only changed if necessary to match host setting.

Definition: An error detection routine in which one data bit per character is setto 1 or 0
so that the total number of bits in the data field is either even or odd.

Serial Cmd: <K100,baud rate,parity,stop bits,data bits>

Default: None

Options: 0 = None 1=Even 2 =0dd
Stop Bits, Host Port

Usage: Only changed if necessary to match host setting.

Definition: One or two bits added to the end of each character to indicate the end of
the character.

Serial Cmd: <K100,baud rate,parity,stop bits,data bits>

Default: One

Options: 0=0ne 1="Two

Data Bits, Host Port

Usage: Only changed if necessary to match host setting.

Definition: One or two bits added to the end of each character to indicate the end of
the character.

Serial Cmd: <K100,baud rate,patrity,stop bits,data bits>
Default: Eight
Options: 0 = Seven 1 = Eight
Note: See USB HID Interface on page 3-23 for protocol information relating to USB.
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Communications

Host Port Protocol

Usage:

Definition:

Serial Cmd:
Default:
Options:

In general, the point-to-point protocols will work well in most applications.
They require no address and must use RS-232 or RS-422 communications
standards.

Protocols define the sequence and format in which information is transferred
between the reader and the host, or in the case of Multidrop, between the
readers and a concentrator.

<K140,protocol,address>

Point-to-Point

0 = Point-to-Point

1 = Point-to-Point with RTS/CTS

2 = Point-to-Point with XON/XOFF

3 = Point-to-Point with RTS/CTS and XON/XOFF
4 = ACK/NAK

5 = Polling Mode

Note: In all protocol modes, the preamble <K141> and postamble <K142> character
strings can be used to frame the decode data, and both are included in calculating the
LRC (Longitudinal Redundancy Check).

Point-to-Point (Standard)

Usage:
Definition:

Serial Cmd:

Used only with RS-232 or RS-422.

Standard Point-to-Point requires no address and sends the data to the
host whenever it is available, without a request or handshake from the host.

<K140,0>

Point-to-Point with RTS/CTS

Usage:

Definition:

Serial Cmd:

A reader initiates a data transfer with an RTS (request-to-send) transmission.
The host, when ready, responds with a CTS (clear-to-send) and the data is
transmitted. RTS and CTS signals are transmitted over two dedicated wires
as defined in the RS-232 standard. Used only with RS-232.

Point-to-Point with RTS/CTS (request-to-send/clear-to-send) is a simple
hardware handshake protocol that allows a reader to initiate data transfers
to the host.

<K140,1>

Point-to-Point with XON/XOFF

Usage:

Definition:

Serial Cmd:

If an XOFF has been received from the host, data will not be sent to the host
until the host sends an XON. During the XOFF phase, the host is free to carry
on other chores and accept data from other devices. Used only with RS-232.

This option enables the host to send the XON and XOFF command as a
single byte transmission command of start (*Q) or stop (*S).

<K140,2>
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Host Port Protocol

Point-to-Point with RTS/CTS and XON/XOFF

Usage: Used only with RS-232.

Definition: This option is a combination of Point-to-Point with RTS/CTS and Point-to-Point
with XON/XOFF.

Serial Cmd: <K140,3>

ACK/NAK

Definition: See the ACK/NAK Options command <K147> on page 3-7.
Serial Cmd: <K140,4>

Polling Mode

Definition: See the Polling Mode Options command <K148> on page 3-8.
Serial Cmd: <K140,5>

Poll Address

Serial Cmd: <K140,protocol,address>
Default: 1

Options: 1to 50

1 = Poll address 0x1C, Select address 0x1D
2 = Poll address Ox1E, Select address 0x1F

50 = Poll address 0x7E, Select address Ox7F

Note: See USB HID Interface on page 3-23 for protocol information relating to USB.
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Communications

ACK/NAK Options

Definition: These parameters take effect for ACK/NAK <K140,4> on the main RS-232 or
RS-422 ports (not on the Auxiliary Port), and are completely independent of
the Polling Mode Options <K148>.

The imager always follows the protocol in both directions (to and from the
host). There is no option to disable it from either direction.

Serial Cmd: <K147,RES,REQ,STX,ETX,ACK,NAK>
RES-NAK Defaults

RES: